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1  Getting Started with Debrief 

1.1  Welcome to Debrief NG 
Welcome to Getting Started with ​Debrief​. In this tutorial, the first in a series aimed at getting you up to 
speed with the program, we will look at the following areas: 

● Document conventions 
● Installing and opening Debrief 
● Welcome to, and working within, Debrief 
● Debrief Preferences 
● Views​, ​Menus​, ​Plot Editor​, and ​Toolbars 
● Shortcut Key Combinations 
● Chart Features 

By the end of this brief getting started guide, you will know where everything is in the program, how to 
work efficiently within ​Debrief​, and be in the best position possible for the remaining tutorials. 

Before going through the areas of ​Debrief ​in detail, it is important to know what ​Debrief ​is all about. So 
let us started with a little background information. 

1.1.1  Background Information 

Debrief​ was developed in the mid 90's by the Maritime Warfare Centre in Portsmouth UK to support the 
analysis and reporting of maritime tactical exercises, and is a free, open source application that makes 
it possible for analysis organisations to run open contests for support and development contracts to 
maintain or extend ​Debrief​. For more information, refer to ​http://debrief.info​.  

1.1.2  About these Tutorials 

Though there is a wealth of information in these tutorials to get you both started and up to speed 
quickly, this will only be achieved by an active involvement on your behalf. As such, in most procedures 
you will see checkboxes in the right margin. These are there to not only check your progress but also to 
help directly involve you while you proceed with learning how to use ​Debrief​. For example, you will see 
something similar to the following: 

1. You will need the following items to work through the tutorials:  

○ A pencil/pen to tick off these checkboxes. ❏ 
○ Access to a PC ❏ 
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○ Have either pre-installed copy of ​Debrief​, a ​Debrief ​CD, or an Internet 
connection to download a copy. ❏ 

2. Having read the previous, do you understand what will be covered in this, the first 
tutorial of ​Debrief​, and what items you need? ❏ 

By checking off these boxes as you go, you can track your progress and see how well you’re doing. 

1.1.3  Document Conventions 

The following conventions are used within the tutorial: 

● Bold ​is used to identify commands, verbal instructions and other essential information, such as 
user interface (UI) details/buttons/names, and for emphasis. 

● “Bold + quotes”​ ​are used to identify filenames and other external references. 

● “Quotes” are used to highlight comments in examples. 

1.1.4  Navigating within Debrief 

When you’re navigating within Debrief, you will need to click on menus, sub-menus, and even sub-sub 
menus. However, though writing it out as “Click on ​File ​on the menu bar, then click on ​Save As​, and 
finally ​navigate to where you want to save your file​,” is descriptive and accurate, it’s pretty laborious 
and wasteful; so, we shorten it and write it as: 

File > Save As > file location 

That’s far more succinct and easier. Next we’ll look at installing and opening Debrief. 

1.2  Installing and Opening Debrief 
Before you install ​Debrief​, please check the following: 

● The main prerequisite for installing ​Debrief​ is to have the latest version of Java installed. So 
download Java from ​Java link​. 

● If you haven’t installed Debrief before, ensure you have downloaded the latest version from 
Github (​https://github.com/debrief/debrief/releases​). 
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● If you have an older legacy version of Windows already installed on your computer, then please 
uninstall that version via  ​Windows > Start menu > Settings/Control Panel > Add/Remove 
Programs​. 

Once you’re ready to go with the latest version of the software: 

1. Unzip it to your computer/network. ❏ 

2. Navigate to the ​DebriefNG ​folder, then double-click on the ​“DebriefNG.exe”​ file to 
run the application. ❏ 

It will take a few seconds to load and, once loaded, you will see the ​Welcome to Debrief NG ​page. 

1.3  Welcome Screen 
The ​Welcome ​screen is displayed on your first visit to Debrief, but it is always accessible from within 
Debrief via the ​Help ​menu.  

When the page loads, you will see the Welcome screen: 
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As you can see, this contains the following 5 buttons: 

1. Overview ​- if this is your first time using Debrief, it’s a good idea to click on this button to get an 
overview of the features. 

2. What’s New​ - we’re constantly updating the software, so if you want to see the exciting new 
features, click on this button. 

3. First Steps​ - we all have to start somewhere; so, if you’d rather read the first steps than follow this 
tutorial, then feel free to click here. 

4. Tutorials ​- if you click on this option, then you’ll see another version of this tutorial. However, it’s 
always handy to know where to find these. 

5. Workbench ​- the workbench is the main interface for performing your plot analysis and other tasks: 
this is the place where you will do all your work. 

I know you’re raring to go, so we won’t go into all the features or what you will find by 
clicking on the above, but I would recommend you to explore and familiarise yourself 
with those elements when you have the time. 

❏ 
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For the next sections, if you’re an experienced computer user then you’ll already know about main 
menus, context-sensitive menus and toolbars; if this is the case, feel free to skip them. However, I 
would recommend that you do read the section on ​Views ​as they are an important component of 
Debrief​. 

1. Click on the ​Workbench​ button. The ​Welcome ​screen will close and you will see 
the​ Create Project ​dialog box. 

 
 

❏ 

2. Every ​Debrief ​project requires a location to save the file. name, so click ​Browse​ and 
select the location where you want to save the file.  

 

❏ 
3. You can leave the ​Add Debrief Samples ​box checked. 

❏ 
4. Click on the ​Finish ​button. The dialog box will close and you will see an empty 

Debrief ​interface consisting of various items and objects (we will go over these in a 
second). 

 

❏ 

5. If you look in the ​Navigator ​‘window’, you will see your new project name folder. ❏ 
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1.4  Views Overview 
In ​Debrief​, each small window is called a ​View​. There are different types of view, all of which perform 
different functions. You already saw the Navigator View.  If you click on the ​Time Controller ​tab (next 
to ​Navigator​), you’ll see we have a set of video-type controls: very useful for displaying time elements 
in ​Debrief​.  

 

Underneath these 2 views are 3 other views:  

Properties 
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Track Tote 

 

Chart Overview 

 

Again, each of these views performs a different function. We won’t look at these now, but these views 
and other interface items such as toolbars, menus, and the plot editor (the large empty space to the 
right of the views) make up a large part of ​Debrief​. 

Please note that there are several other views that you can add whenever required from the ​Windows 
menu. For more information, refer to the following tutorials: 

● Working within Debrief 
● Working with Views 

Currently, you will not see any data loaded and the interface may seem a little daunting at first, but we’ll 
work through all of these items and you’ll come to realise that it’s actually quite easy to work with. 

However, as with any new application, it’s a good idea to configure it exactly how you want it for your 
own purposes. In ​Debrief​, these are called ​Preferences ​and, though you don’t know that much about 
the software as yet, you will understand each of these settings. 
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1.5  Debrief Preferences 
As mentioned, all software is configured a certain way ‘out of the box’, and ​Debrief ​is no different. 
However, it’s most likely that you’ll either want to change the way it’s setup or know where to make the 
changes if you later decide to do so. For example, if you prefer ​Over the Ground (OTG)​ as the default 
import mode for track files, then you can change the setting here; the same if you wanted your ​default 
range units​ in ​miles ​or​ nautical miles​, etc. 

Debrief ​offers a large number of different settings and configurations to suit the needs of its users, all of 
which can be changed if you prefer alternatives to the preset ones. To change these, follow the steps 
given below: 

1. In Debrief, click on ​Window > Preferences​. The ​Preferences ​dialog will open. 

We will now look at some of the important settings. Though we won’t change any of the 
settings (as it’s setup just right for the subsequent tutorials), it’s handy to know where 
they are, before you start using them. 

❏ 
 

 

2. Click on ​Maritime Analysis ​and you will see 3 settings groups: ​Default Track 
Import Mode​, ​Default Range Units​, and ​Relative Bearing Format​. 

 

❏ 
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3. Again, we will leave these at the default setting, but just check that you want ​Ask 
User​ for the ​Default track import mode, yd ​for th​e Default range units​; and ​UK 
format (R180,,G180)​ for the ​Relative bearing format​. If not, make your change(s). 

 
 

❏ 
4. Once you are done, click on the ​Apply ​button to commit the changes: ​Apply ​makes 

the changes and leaves the dialog box open, whereas clicking on ​Ok ​commits the 
changes and closes the box. 

 

❏ 
Now we will look at the different location format options.  

5. Click on the drop-down arrow next to ​Maritime Analysis​ and select ​Formatting​. 

 
❏ 
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6. You can now choose your location format, either​ DD°MM.MMM’​ or ​DD°MM’ 
SS.SSS”​—again, we want the default option. ❏ 

7. If you have downloaded the ​“Natural Earth” ​set, click on this in the ​Maritime 
Analysis​ sub-menu. ❏ 
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8. Click on the ​Browse ​button, navigate to the download location, and double-click on 
the file to load it. ❏ 

9. Finally, click on the ​Ok ​button. 
❏ 

Those are the only settings we need for our tutorials. For the other preference settings, refer to the 
User Guide​ for further information. Now we will look at working with ​Debrief​. 

1.6  Working Within Debrief 
The UI for ​Debrief ​(called the ​workbench​) is centred on what is called the ​plot editor​; and again, this 
in turn is surrounded by a series of small windows, called ​views​. We’ll come onto these shortly, but the 
plot editor​ is where your plots will be displayed and where you can work on them. 

 

Within the workbench itself, the base component for working is the project (we already created our 
base project in the previous section, ​Welcome to DebriefNG​), and everything we see in the UI is 
related to the selected project. 

The first thing we must do is to define the workspace for this project. To do this, we need to ensure the 
Navigator ​view is open; and, unless you accidentally closed it, it should be; but we’ll quickly go over 2 
methods of opening this view as it is one of the more common views in ​Debrief​. The ​Navigator ​view 
to ​Debrief ​is akin to Windows Explorer to your operating system, so it’s essential to know how to open 
it. 
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1.6.1  Opening the Navigator view 

The easiest ways to open the ​Navigator ​view are either via the menu or the ​Quick Access​ dialog. 

1.6.1.1  Opening Views  

To open views using the menus (remember, we’re just concerned with the ​Navigator ​view here, but 
these steps apply to any Debrief view): 

 

1. Click on ​Window ​on the menu bar. ❏ 

2. Mouse-over or click on ​Show View. ❏ 

3. Click on ​Navigator ​and that view will open. ❏ 

Using the convention I described before, this would be: 

Window > Show View > Navigator. 
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We will use this convention from here on. 

However, a much quicker way to open a view is to use a keyboard combination—a sequence of key 
presses to perform an action; the only difference here is you must know the name of the view you want 
to open. 

1.6.1.2  Opening and Closing Views (Using Quick Access) 

To open the ​Quick Access​ dialog and locate any item within ​Debrief​: 

 

1. Press ​Ctrl+3 ​on your keyboard and the ​Quick Access​ popup dialog will show. ❏ 

 

2. In this instance, we are searching for the ​Navigator ​view, so just start typing 
‘navigator’ into the search field and, before you’ve finished typing the word, you will 
see ​Views - Navigator - Genera​l appear. 

 

 

3. Click on it and the ​Navigator ​view will show in the top left of your window. ❏ 
The ​Quick Access​ dialog also ‘remembers’ your choices, so the next time you open it you will see 
recently selected items listed beneath the search field; just click on the one you want and it will open. 
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As you can see, opening views is easy; so is closing them: to close a view, click on the ​X ​icon on the 
view name tab. 

 

Now we’ve looked at opening and closing views, let’s have a look at them in a little more detail. 

1.7  Working with Views 
As mentioned, views are small viewing panes which present information specific to the task you are 
carrying out in the plot editor in different ways. For example, one view may display tabular information 
about the properties of an object: its position, its color, etc., (the ​Properties ​view); whereas, another 
will have video controls to show time (the ​Time Controller​ view); and yet another will show a graphical 
overview of the chart in use (the ​Chart Overview​ view). Again, views display supporting data or 
properties about the selected data or tasks. As you will see, they are an important element of Debrief 
and you will use them extensively. 

Note​: Selecting a view makes it active. The active view will have its name tab in blue color and it will 
also have a blue border. You can use the ​Ctrl ​and ​Shift ​key on your keyboard to select multiple 
objects; when this occurs, all the selected items become active. We already know how to open and 
close views, it is time to know how to reposition or move them.  

1.7.1  Moving Views 

Moving views is very easy and they can be positioned anywhere around the plot editor by 
dragging-and-dropping. This is very handy as not only can you move the important features into 
prominent positions on your monitor when you need them, but you can also move them out of the way, 
onto another monitor (if you have multiple monitors), or even drop them into an already open view to 
stack them up (to save screen space). Try it: 

1. Click on the tab of any open view to make it active (the tab will turn blue). 
❏ 

2. Now, click on the tab itself and, keeping the mouse button pressed, drag it across 
the plot editor area. As you approach the edges of the plot editor, you will see the 
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cursor change to a black direction arrow and a placeholder box will appear to one 
side of the ​plot editor​; if you wish, you can drop the view into place there. 

 

❏ 

3. However, if you drag it further onto to another view, the cursor will change to a 
graphical set of files (or folders); you will also see a shaded border around the view 
you are over, showing you where it will be placed. If you drop it now, the view will 
add to that view set (or ​stack​), and become active. 

 
 

❏ 
4. But, if you didn’t drop it on the view, deciding instead to drop your cursor either onto 

the name tab of the view you are over or right next to it, you will see a dotted box 
appear showing you where your view will be placed. As soon as you drop the view, 
it will dock in that position and become the active view. 

 
 
 

❏ 
Note​: within the confines of the central editor pane, you can also do the same with the plot editor. 

1.7.2  Resizing Views 
In addition to the standard Windows ​minimize ​and ​maximize ​functionality (the two 
small icons in the top right-hand corner of each view), you can also resize views by 
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moving your mouse cursor over the view’s border. As soon as the cursor changes to a 
directional arrow, left-click on the border and then drag it in one of the indicated 
directions. Once it’s in position, release the mouse button. Try this with the ​Navigator 
view now. 

 
 

❏ 

As you probably realise, many of ​Debrief​’s functions are centered around using the mouse, so we’ll 
first look at menus and then at toolbars. 

1.8  Defining Your Workspace 
In the previous tutorial, we learnt about the ​workbench​ (the ​Debrief ​UI), and in this section, we will 
look into defining your workspace covering the following sections.  

● Generating a Project for Your Data 
● Generating Links to your Existing Data 
● Configuring Background Data 

1.8.1  Generating a Project for Your Data 
Before we create a new project, we first need to check whether or not we need one. 

Check Whether You Need a Project 

If the ​Navigator ​view has no data, then you will need to create a new project. If the 
Navigator view already has a folder icon (possibly containing sample data), then you're 
ready to go on to the next section in this tutorial. 

 
 

❏ 
Create a General Project 

To create a general project, follow the steps given below: 

1. Right-click anywhere in the ​Navigator ​view, the sub-menu will display. ❏ 
2. Click ​New ​and from the ​New ​sub-menu, select ​Project… 
 

 

❏ 
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3. The​ New Project wizard​ will open. Click on the ​General ​folder, then select ​Debrief 
Project​. 

 

 

❏ 

4. Click on the ​Next ​button. ​Create a project​ dialog will display. 
 

 

❏ 

5. Select the location where you want to place the project files by clicking ​Browse 
button. You can even create a new folder and place the files. 

 
Note​: If the project with the same name is already loaded in ​Debrief​, then you may 
have to select a new location or folder.  
 

❏ 
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6. Click on the ​Finish ​button. ❏ 

 

You will see the new project in the ​Navigator​ view. 
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1.8.2  Generating Links to Your Existing Data 

As mentioned previously, ​Debrief NG​ stores its data in a local folder called a ​project​. While these are 
frequently created afresh to store new analysis data, it's also possible to denote your existing data 
directories as sub-folders (via links). 

The following procedure guides you through generating links to your existing data folders. However, if 
the ​Create Project ​form opened when the application started, and if you provided both a project name 
and indicated that you would like sample data to be imported, then you can skip the following steps and 
move on to the next tutorial, ​Viewing Data​. 
 
Open Navigator 

If the ​Navigator ​view is closed, open it by using the shortcut key ​Ctrl+3​, and then either 
clicking on the option in ​Previous Choices​, or starting to type ​navigator​ in the search 
field and clicking on the appropriate link when it appears. 

❏ 
Check Whether You have a Workspace or Not 

Before you can link the existing data, you need to define a project for your work. If your ​Navigator 
view has no data, you must follow the ​Generating a Project for Your Data​ tutorial. 

Add a New Folder 

To add a new folder, follow the steps given below. 

1. Right-click on your current project in the ​Navigator ​view, the ​New ​sub-menu will 
show. 

 

❏ 
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2. Select ​Folder ​and the​ New Folder​ wizard will open. 
 

 

❏ 

Here instead of creating a fresh child folder to store our data, we're going to link to an existing folder. 

3. In the ​New Folder​ wizard, click on the ​Advanced ​button, and the ​Advanced 
options ​will show. ❏ 
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4. Select ​Link to alternate location (Linked folder)​. ❏ 
5. Click on the ​Browse...​ button and navigate to an existing data folder on your 

machine or the network. ❏ 
6. Once complete, click on ​Finish ​to close the wizard and link to your existing data ❏ 

Note​: if you don't have your own data, please use either of the following: 

● For a deployed ​Debrief​, use the​ “sample_data”​ folder that's installed in your ​Debrief 
installation folder. 

● If you are running a development version of ​Debrief​, use 
org.mwc.cmap.combined.feature/root_installs 

If you have followed these steps, you will have created a link to the sample data; however, if you need 
to load data from other data directories, repeat this process as often as required, but use a shared 
working folder. 

1.8.3  Configuring Background Data 

In addition to plotting your recorded vehicle data, ​Debrief ​is capable of showing a number of datasets 
in the backdrop form. 

In the past, we offered the Vector Product Format (VPF) vectored dataset and the ETOPO-2 gridded 
bathymetry, but these have been superseded by the shiny new ​Natural Earth​.  
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Note​: All ​Debrief ​installations come with a small, low resolution Natural Earth dataset. But you can 
even download and install two much higher resolution datasets (in a single download). This higher 
resolution dataset includes many names of physical features and locations. 

1.8.3.1  Getting Natural Earth Dataset 

So by default,​ Debrief ​has​ ​a small, low resolution subset of the ​Natural Earth​ dataset, sufficient to 
provide coastlines and country boundaries. With higher resolution data, you can make your analysis 
plots much more attractive.. 

Your workplace may already have a network copy of ​Natural Earth​; and, if your IT security policy 
permits it and you have sufficient storage space on your machine, you can copy the data to your hard 
drive for better performance. 

1. If you don't have access to a copy, navigate to 
https://github.com/debrief/NaturalEarth  

2. Click ​Clone or Download​ drop down list and click ​Download zip ​button (file size is 
approximately 25 MB). 

❏ 

 

Once you have downloaded the zip-file, just unzip it and save it to a safe place on your hard drive. 

1.8.3.2  Configuring Debrief with Natural Earth Data 

The next step is to configure ​Debrief ​with the ​Natural Earth​ data: 

1. Click on​ Window > Preferences ​(or press ​Alt, W, P​). The ​Preferences​ dialog will 
display. ❏ 
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2. Click on the arrow next to ​Maritime Analysis ​and select ​Natural Earth​. ❏ 
3. Click on the ​Browse ​button to navigate to your unzipped ​Natural Earth​ folder. ❏ 
4. Click on ​Ok​. ❏ 
1.9  Menus 
Debrief ​has a number of different menus which provide different functions. These are the main menu, 
context-sensitive menus, and view drop-down menus. We’ll look at each of these in turn. 

1.9.1  Main Menu - Reduced 
Without a Debrief file open, you will only see a reduced main menu set of 5 items: ​File​, ​Edit​, ​Run​, 
Window​, and ​Help​. So, we’ll open a file to see the full set. 
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1.9.1.2  Opening a Debrief file 

To manage or open files, we need to go to the ​Navigator ​view. If it isn’t open, open it. You can either: 

● Click on ​Window > Show View > Navigator​. 

● Press ​Ctrl+3 > Quick Access > [click on Navigator - General] 

 

❏ 

Now, in the ​Navigator ​view: 

1. Click on the drop-down arrow next to “​Debrief​” and it will expand. 

 

❏ 

2. Click on the “​sample_data​” folder and locate the file ​“boat1.rep”​. 

 

 

❏ 

3. Double-click on “​boat1.rep​” and the ​Select track mode ​dialog will show 
(remember, we accepted the default in ​Preferences ​to always ask us the track 
mode). 

❏ 
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4. Select ​Over the Ground (OTG)​. ❏ 
5. Click on ​Ok​. After a second or two, the​ boat1.rep ​plot will display in the plot editor 

part of the UI. ❏ 

 

You will also see the full main menu set as well as the main toolbar set. 
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1.9.2  Main Menu - Full 
The 8 main main menus items are ​File​, ​Edit​, ​Run​, ​Chart Feature​, ​Drawing​, ​View​, ​Window​, and 
Help​. These are self-explanatory and mostly mirror many of the principal functions common 
throughout apps/programs today. 

 

Using the menus is very easy, especially with the mouse. However, you can also access the main 
menu items using the keyboard. We’ll discuss more about this in ​Shortcut Key Combinations​. 

The second type of menu we have are called ​context-sensitive menus​. 

1.9.3  Context-Sensitive Menus 

One mostly unused function when using the mouse with Windows is the right-click mouse button or the 
right-click keyboard button (this is the one with the graphic on it, normally 2 to the right of your keyboard 
space-bar). 

Using either of these functions will cause a pop-up menu to appear—this is called a ​context-sensitive 
menu​. Try it now. 

In the ​plot edito​r: 

1. Right-click on the grey area of the plot. You will see a popup menu with 3 options: 
Copy Cursor Location​, ​Edit base chart​, and​ Edit Projection​. ❏ 

 

Admittedly, these aren’t much help to us at the moment, but it’s a quick way of accessing required 
information or attributes and functions of the chosen object.. 

2. Now, at the top of the track (the entire line on the plot is the track), you can see a 
straight yellow section. Right-click anywhere on it and a context-sensitive menu with 
a large range of options will display. 

❏ 
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3. The 3rd option down is ​Reset color​; select it and that small part of the yellow track 
will change color to red. ❏ 

 
Of course, there are many other things we can do with these options, but it’s handy to know they are 
there and it’s far quicker than using the main menu all the time. 

You might think this is no big deal, but when you’re using a computer all day shortcuts like this help 
enormously. As well as saving you time and energy, these context-sensitive menus also show you 
what other functionality is available to you; and, as well as being a neat training aid, are great for 
improving your efficiency and capability with the program. The last menu set is the view drop-down 
menu. 

1.9.4  Viewing Drop-Down Menus 
All views have a drop-down menu which further narrows-in on the functionality for the particular 
subset of tasks you are performing. For example, not only can you right-click on every individual 
element or attribute in a view, but you can also click on objects such as column headings as well as 
the small drop-down arrow in the top right-hand corner of each view: each one will provide with you a 
new set of options specific to that attribute/view. 

With our ​boat1.rep ​ file: 
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1. Identify the ​Outline ​view (if it isn’t visible, open it:​ Window > Show View > 
Outline​). 

 

❏ 

2. Within that view, click on ​Track:NELSON ​to expand it. You should see ​120500.00 
(402 items) ​as the first item in the list (this contains the information about the entire 
track in our plot editor). 

❏ 

3. Right-click on ​120500.00 (402 items)​. ❏ 
4. Mouse-over ​120500.00​ and another popup will show. ❏ 

 

5. Mouse-over ​Linestyle ​and select​ Long dashes​. The track now changes to long 
dashes. ❏ 
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Next, we’ll go one step up, to the track-level: 

1. Still in the ​Outline ​view, right-click on ​Track:NELSON​. ❏ 
2. Mouse-over ​NELSON ​and a popup will show. 

 

❏ 

3. Mouse-over ​Color ​and select ​Blue​, most of the track will change color to blue. 
❏ 

Now, we’ll go another step up, this time to the view-level: 
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1. Click on the square icon (Hide Item) in the ​Outline ​view. The track will disappear 
from the plot (it’s still there, just hidden 

 

2. Click on the checked square icon (​Reveal Selected Items​ and the track will be 
shown again in the plot editor. 

❏ 
 

 

❏ 

Note​: You can perform these functions at different levels in the view, e.g., you can also hide/reveal at 
the track and node levels, but it all depends on what you are actually working on in the plot editor. 

1.10  Plot Editor 
The ​Plot Editor​ itself is locked to the centre of the user interface, and is where you view and work on 
your projects. You can have multiple files open in the central area, each of which has its own tab 
(though I wouldn’t recommend too many as it will become cluttered). 

If you do work in a plot editor, then an asterisk (​*​) will appear in its tab, denoting any unsaved changes. 

With the changes, we made to the ​Nelson ​track in the previous section: 

1. Click on ​File > Save​ and because our original file has been changed we must save 
it as a different format (we will come onto the different file types later). ❏ 

2. Click on ​Ok ​and the ​Save As​ dialog will display. ❏ 

3. Select the project folder you created earlier, and click on ​Ok​. The ​“boat1.rep”​ file 
will be saved as ​“boat1.dpf”​. The active plot tab name will change, and the asterisk 
will disappear. ❏ 

Note​: You can also press ​Ctrl+S​ on your keyboard to save the active plot. 

1.10.1  Navigating within the Plot Area 
In addition to using the mouse to move around the plot area, there are other ways of 
navigating, including using the tab key to cycle through the 5 drag modes, as shown 
below. If you have a mouse with a wheel, you can press the ​Ctrl ​key and then use the 
mouse wheel to zoom in and out of the plot. 

❏ 
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1.10.2  Moving Plots 

You can move the plot order by clicking on the plot’s tab, and then dragging it into a new position 
alongside an existing tab. 

1. In the ​Navigator ​view, double-click on the file “​boat2.rep​” to open it. 
❏ 

2. Select ​Over the Ground (OTG)​, then click on ​Ok​. The file will display in a new tab. 
❏ 

We now have 2 tabs open: ​boat1.dpf​ and ​boat2.rep​. 

3. To move them, click and hold on the ​boat1.dpf​ tab. ❏ 

4. Either drag the tab on top of or next to the ​boat2.rep ​tab (you will see the mouse 
cursor change to a stacked file set and a shaded box will appear). ❏ 

5. Release the mouse and the tabs will have swapped positions. ❏ 
 

Now, we’ll take this one step further and view multiple plots. 

1.10.3  Viewing Multiple Plots 

Debrief ​allows you to view multiple plots in one window (much in the same way as you can arrange 
windows in other applications): 

1. Click and hold on the ​boat2.rep ​tab to select it. ❏ 

2. Now, depending on where you want to position the ​boat2.rep​ editor in relation to the 
boat1.dpf ​editor, drag the selected tab towards the edge of the screen (top, bottom, 
left or right). As you go, you will see the stacked files mouse cursor change to a 
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black arrow and a shaded box will appear showing where the editor will be placed if 
you release the mouse. ❏ 

3. Release the mouse where you want the ​boat2.rep​ file to be positioned. The plot will 
then show in the new location. 

 

❏ 

You can repeat this process with other files to further segment your plot editor area. ❏ 
1.10.4  Rearranging or Removing Plots 

● To ​rearrange plots​: Drag-and-drop a plot onto the top, side, or bottom of 
another plot and, when the shadow border that shows where the plot will be 
positioned is in the right place, release the mouse. 

❏ 
● To ​remove plots​: Either close the plot by clicking on the ​X ​in its tab, press 

Ctrl+W ​on your keyboard, or click on​ File > Close​. ❏ 
Do this now with the​ shapes.rep ​plot: 
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1. Open the ​shapes.rep ​plot as you ​opened boat1.rep​.  

2. Click and hold on the ​shapes.rep​ tab to select it. 
❏ 

3. Drag the tab on top of the ​boat1.dpf ​tab and, when the shadow border appears, 
release it. ❏ 

4. Now, click on the ​X ​in the ​shapes.rep​ tab to close it.  ❏ 
You should now have ​boat1.dpf ​and ​boat2.rep ​side by side. We will now look at ​Debrief​’s toolbars. 

1.10.5 Exporting Plot 
As an analyst, you will frequently use ​Debrief ​plots in various applications, ​either in vector (WMF) or 
bitmap (BMP) formats​. Based on the application, you can adjust the size of the plot to maintain 
uniformity.  
 
In addition to using still snapshots of ​Debrief ​plots in PowerPoint, it’s possible to include animations of 
vessel interactions. These animations add very little to the file size (typically 10s of KBytes) and don’t 
pose the security risk that Macros can do. Furthermore they can convey the vessel interactions in a 
more engaging way. 
 
Dynamic PowerPoint animations are produced by adding a collection of ​Debrief​-style icons to a master 
template slide. The master template will contain a background, placeholders for the map, time, and 
narrative events, plus some styled graphics that are used as ​donor​ elements for the ​Debrief ​symbols. 
So we configure a master template first before exporting a plot to PowerPoint. 
 
In this section, you will learn how to set the master template, how to resize the Plot Editor  
and how to export the resized dynamic scenario to PPTX. For more information, refer to the following 
sections: 
 

● Configuring Master Template 
● Resizing Plot 
● Preparing to Present 
● Exporting Dynamic Scenario to PPTX 

1.10.5.1 Configuring Master Template 
When you want to use an animation of a dynamic scenario, of a plot, in your presentation, the size of 
the plot must be uniform. This will make your presentations more appealing. For that we need to 
configure the master template of the application and resize the plot to the same size as that of the 
master template. This way you can ensure that the aspect ratio of the plot will not be distorted, when 
you export it. 
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Let’s configure the master template.  

1. Navigate to ​Window > Preferences.​ The ​Preferences ​dialog will display. ❏ 

 

2. Click on the arrow next to ​Maritime Analysis. ​The drop down menu will display.  ❏ 

3. Click on ​Debrief-specific settings. ​The ​Debrief-specific settings​ will display. ❏ 

4. Click on the ​Browse ​button and select the master template by navigating to the 
Debrief ​folder (on your system) > ​sample_data ​> ​other_formats ​and then selecting 
the ​master_template.pptx​ file. 

❏ 
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5. Note down the ​Map element dimensions ​(​Width 528px ​and​ Height 368px ​of the 
master_template). ❏ 

6. Click ​Apply ​and then click ​OK. ​The selected preference will be set. ❏ 

Opening Sample Scenario 
 
Before you start exporting, you need to open the sample scenario, the plot of which you wish to export. 

1. In the ​Navigator ​view, drag the file ​sample.dpf ​and drop it into the ​Plot Editor​. 
The ​sample.dpf​ tracks will display.  ❏ 

2. Click on the ​Fit to window  button to make the entire plot visible. ❏ 

 

3. Open the Views: ​Navigator,​ ​Outline​, ​Time Controller​, and ​Properties​. 
❏ 
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1.10.5.2 Resizing Plot 
If the size of the exported PowerPoint slide (or if a ​Debrief ​plot is copy/pasted as a still image to 
PowerPoint) is different than the size of the plot, the plot image will be resized and as a result of which 
some hairwidth lines may disappear in the image, particularly if presented via a projector. So, you 
would require to make the ​Debrief ​plot either the exact same size as the PowerPoint slide or to make 
the ​Debrief​ plot have the same aspect ratio as the target location. 
 
Note​:  

● You can also export a plot, as a still image, to ​vector (WMF) or bitmap (BMP) formats. To export 
to WMF format, ​navigate to ​File > Export to WMF​.The exported file will be saved in the ​Debrief 
installation directory. 

● You can also copy the plot and paste into an image processing tool. To copy the plot, click on 
Edit ​in the ​Main Menu​ and then click ​Copy​. The plot will be copied to the clipboard. You can 
then paste the copied image in any image processing tool and save it any required format, such 
as JPEG, PNG, BMP and so on.  

1. Now in ​sample.dpf​, double-click anywhere on the empty plot area.  ❏ 

2. The ​Properties​ view will show the size of the plot in the ​Current plot size​ field. ❏ 

 

3. Drag the ​Outline ​view window and drop it below the ​Plot Editor​. ❏ 
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4. Now resize the ​Plot Editor​ by dragging the left side (highlighted in red rectangle in the 
above screenshot) and the bottom (highlighted in green rectangle in the above 
screenshot) of the ​Plot Editor​ window. As you drag the ​Plot Editor​, you can see that 
the current size in the ​Properties​ view will change accordingly. 

 
Note​: As you configure the ​Plot Editor​, your plot is also resized.  

❏ 

5. Adjust the size of the ​Plot Editor​ to the size of the master_template, which is 528px 
width and 368px height (Remember, we established that the master template had these 
dimensions). 

❏ 
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1.10.5.3 Preparing to Present 

Now it is time to prepare for presenting. Follow the steps given below: 

1. Zoom in on an area in the ​sample.dpf ​file. In this example, we are zooming in, on the end 
of the ​sample.dpf​ file. ❏ 

2. In the ​Time Controller​ view, move the slider so that both the vessels are visible. 
❏ 

 

3. In the ​Time Controller ​toolbar, click on the ​Edit Time Controller Properties​ button  ❏ 

4. In the Properties view, set the value of ​Small Step​ to ​1 Minute​ and the value of ​Step 
Interval​ to ​⅕ second​. These settings mean that five times per second ​Debrief ​will step 
forward one minute, a rate that proves effective for this engagement, but others may need 
larger/smaller ​Small Step​ sizes. 

❏ 
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1.10.5.4 Exporting Dynamic Scenario to PPTX 
After you have prepared your plot for presenting, you can export a dynamic scenario to PowerPoint. We 
will learn how to export in this section.  

1. In the ​Time Controller view, ​click on the record button  (tooltip for this button will 
show ​Start recording for screen positions, for export​)​ to start recording the 
engagement. The events will begin to unfold. 

❏ 

2. Click on the stop button  at the time at which you wish to stop recording. The 
Debrief export ​dialog will display. 

❏ 

 

3. Specify the ​Export Location ​and enter the ​File name​ that you wish to export the plot to. 
Select the ​Open exported PPTX​ checkbox and then click ​Export​. The PowerPoint file 
will open. 

❏ 

4. In the PowerPoint file, ​click on the ​ANIMATIONS​ tab, then click ​Preview​. Alternatively, 
you can switch to the slideshow view. ❏ 
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1.11  Toolbars 
In the same way that ​Debrief ​has menu options for the application’s main functions, there are 4 types 
of toolbars to assist you: 

● Main Toolbar​ - Provides functions specific to the application/workbench. 

● View Toolbars​ - These are specific to views and provide functions related to the selected view. 

● Fast View Toolbar​ ​- Is available in the bottom-left of the screen and enables faster access to 
the selected views. 

● Perspectives Toolbar​ ​- Are not used in ​Debrief ​at present, please refer to the ​User Guide​ ​for 
further information. 

We will look at each of these in turn. 

1.11.1  Main Toolbar 
The main, or ​Workbench​, toolbar contains a combination of a number of mini 
toolbars—kept apart by a vertical dotted-line; and, grouped buttons—kept apart by a 
vertical solid line (a separator); refer to the image below for further details. You can 
move the mini toolbars by clicking on the dotted lines and dragging horizontally or 
vertically; and, if you mouse-over any of the buttons, a button tooltip will appear 
explaining the main function of that button.  

 
 
 
 

❏ 
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The mini toolbars are as follows (from left to right): 

● Save ​- Saves the project with the currently saved name. 

● Create project ​- Initiates the ​Create a project​ wizard. 

● Drawing Tools​ - Has buttons which allow you to view plot layers or to place objects such as 
shapes, labels, range rings, tracks, and vectors onto the plot. Refer to the ​User Guide​ for 
further details. 

● Natural Earth - ​Adds a ​Natural Earth​ reference backdrop to the plot, showing ocean contours, 
coastlines, countries and major cities. 

● Plot Management Tools ​- This group of 9 buttons is split into 3 parts by separators—solid 
vertical lines between buttons. These buttons allow you to perform various management 
functions within the plot editor, including object repositioning, measuring, zooming in and out, 
etc. 

From the image above, you can see that the section labelled ​Drag Mode ​contains 6 
buttons; it’s important to note that only one button from this group can be selected at a 
time. The first 3 buttons of this group—​drag track segment​, ​drag whole component 
and ​drag whole feature​—are used to drag and reposition objects on the plot. The next 
button to the right is used to ​measure range bearing​ between 2 objects; then, to the 
right of that, and to the left of the first separator, are the ​pan ​and ​zoom in ​buttons 
which allow you reposition and increase plot magnification, respectively. 

❏ 

To the right of the separator, in the second group, is the solitary ​zoom out​ button—its 
function is self-explanatory and this button can be used in conjunction with all the 
buttons in the first group. 

 

❏ 
Finally, to the right of the second separator, in the third group, we have the​ fit to 
window ​and​ redraw plot editor​ buttons, respectively—again, these are 
self-explanatory. 

 

❏ 
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Note​: as seen in the above image, if you have also loaded the​ Natural Earth ​set, this will show in the 
toolbar area also. 

We won’t go over all of these functions, so refer to the ​User Guide​ when necessary. 

1.11.1.1  Show/Hide the Main Toolbar 

You can show/hide the main toolbar by clicking on ​Window > Show/Hide Toolbar​. ❏ 

1.11.2  View Toolbars 

Each view also has its own mini-toolbar which provides functionality specific to that view. 

1. Click anywhere on the ​NELSON ​track in the ​boat1.rep​ editor; the details of that 
track will appear in the ​Outline ​view. ❏ 

2. In the ​Outline ​view, click on ​Track:NELSON ​to select it. ❏ 

3. In the ​Outline ​view’s mini-toolbar, click on the empty check box, second from the 
right-end—the ​Nelson ​track in the plot editor will disappear. ❏ 

4. In the same mini-toolbar, click on the check box with the tick in it—the ​Nelson ​track 
will reappear.  ❏ 

1.11.3  Fast View Toolbar 

This particular toolbar contains what are called ‘​fast views​’—shortcuts to frequently-used views. By 
default, this toolbar resides in the bottom-left of the interface, underneath the ​Outline ​view (at the 
moment), but it can be dragged to any position around the outside edge of the interface. 

 

1. Move your mouse cursor over the dotted vertical line on the ​Fast View​ ​toolbar ​and 
the cursor will change to a 4-direction cursor. ❏ 
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2. Left-click and drag it to the top-right corner of the UI (next to the button which says 
Tactical Analysis​, or part thereof). ❏ 

3. Release the mouse and the​ Fast View toolbar ​is now in the top right corner of the 
UI. ❏ 

Now we will add a view to the toolbar: 

 

4. Right-click on the ​Navigator ​view tab and select ​Fast View​. The ​Navigator ​view 
button will now be added to the ​Fast View​ toolbar. ❏ 

Note​: You may find it helpful to keep the ​Navigator ​view in the ​Fast View toolbar​ as you will likely only 
want it visible when you need to see and open files/data. 

You will notice that both these views have disappeared from the ​Workbench​. This is because views in 
this toolbar become ​toggle options​: you click once on the button to show it (toggle on), and click on it 
again to hide it (toggle off). 

Note​: These icons do look similar, so until they’re familiar, remember to mouse-over each to see the 
tooltip before clicking on it. 

5. In the ​Fast View toolbar​, click on the left-most button in the toolbar and you will see 
a drop-down list of all views in ​Debrief​. ❏ 

6. Select the ​Properties ​view and the button will display as the 3rd icon in the toolbar; 
the ​Properties ​view will also show. ❏ 

 

You can drag any view and either stack or position it in the same way as we did with 
the ​boat1.rep ​and​ boat2.rep​ files before. ❏ 
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1.11.4  Perspectives Toolbar 

By moving the ​Fast View toolbar​ to the top right, we nudged the ​Perspectives ​toolbar to the side. At 
the moment, the ​Tactical Analysis​ button is selected, but the other functions it offers are not currently 
used in Debrief. Refer to the ​User Guide​ for further details about this. 

Now that we’ve covered views, menus and toolbars, we’ve seen that navigating, moving and 
manipulating objects with the mouse is standard functionality known to us all. Equally useful, but much 
less common, is the use of shortcut key combinations. 

1.12  Shortcut Key Combinations 
If, like me, you prefer to use the keyboard where possible, then you can use what are called keyboard 
combinations to perform common tasks. Keyboard combinations (or shortcut key combinations) consist 
of a sequence of keys which together perform a certain action in the program. For example, a common 
keyboard combination/shortcut in any program is ​Ctrl+S​.  

1.12.1  How to Find Out What the Shortcut Keys Are 

To find out what other shortcut keys work: 

1. Press the ​Alt ​key and look at the main menu. By default, the ​File ​menu is selected 
(it’s the first in the list); but, if you look at the initial letters of each menu item, they’re 
underlined. 

❏ 

2. Pick any one of those underlined letters and press that key on your keyboard. A 
drop-down menu will appear, and you can see the options in that menu. 

3. View the list of shortcut keys by navigating to ​Window > Preferences > General > 
Keys. 

❏ 
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1.13  Chart Features 
You can use a number of chart features to enhance the ​plot editor ​and assist with your analysis. When 
you add a feature to the chart, these will appear in the ​Outline ​view under the name ​Chart Features​. 
We will do this now. 

1.13.1  Add a Chart Feature 

Adding a chart feature will not open the ​Outline ​view, so we’ll do that first: 

1. Press ​Ctrl+3​ and start typing “outline” in the ​Quick Access​ dialog. When​ Outline - 
General ​appears, click on it to open the ​Outline ​view. The view will display and you 
can see the ​Chart Features​ folder has already been added from the previous step. 

 
 

❏ 
2. Click on the ​Chart Features folder​ to expand it and you will see the ​Grid objec​t is 

already there. 

 

❏ 
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3. On the main menu, click on ​Chart Features​ and select your required feature (I 
selected ​Local Grid​ - this differs from grid in that you can modify a local origin by 
changing the ​Origin ​attribute in the ​Properties ​view). 

 

❏ 

4. Your chart feature will be added to the ​Outline view > Chart Features ​and be 
visible in the plot editor. ❏ 

 

From here, you can manage and manipulate the features. 
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1.13.1.1  Modify Local Grid 

Now we'll modify the ​Local Grid​ origin as we would to reflect a custom exercise grid: 

1. Double-click on ​Local Grid​ in the ​Outline ​view. The Properties view for the Local 
Grid will open. ❏ 

2. Locate the ​Origin ​property and click on the down arrow. ❏ 
3. Click on the ​Lat Minutes​ value and change it to ​11​. ❏ 
4. Change the ​Lat Seconds​ value to ​10.63​. ❏ 
5. Change the ​Long Minutes ​value to ​41​. ❏ 
6. Then, change the ​Long Seconds​ value to ​52.37​, click away from the attribute to 

enter it. ❏ 

The​ Local Grid​ origin should now be on top of the white square on the ​Nelson ​track. ❏ 

 

Two of the more common and useful chart features include scale and grid. 
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1.13.1.2  Add Scale 

When you add the scale (​Chart Features > Scale​), the ​Properties ​view for the scale will become the 
active view. Here you can modify a number of attributes, including: 

● Color 

● Location 

● Scale 

● ScaleStep, etc. 

To change the color: 

1. In the ​Properties ​view, click on ​Color Value​, and an ​ellipsis button​ will show. 
❏ 

2. Click on the ​ellipsis button​ and the ​Color ​palette will show. 
❏ 

3. Select a different colour, one which will stand out against the editor background, 
then click on ​Ok​. ❏ 

4. The ​Color ​palette will close and the scale will change to the selected color. 
❏ 

 

To change the display units: 

● In the ​Properties ​view, click on the ​Value ​cell next to the ​DisplayUnits 
attribute and a drop-down arrow will appear. ❏ 

● Select your preferred units scale; I chose ​nm​. Click away from the ​Value ​cell to 
enter this value. The ​scale ​on the ​plot edito​r will update accordingly. ❏ 
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1.13.2  Undo a Chart Feature 

To undo a ​Chart feature​, either: 

● Click on ​Edit​ in the ​Main Menu​ and then select ​Undo [feature] ​or  

 

● Use the shortcut key combination ​Ctrl+Z​ to undo the most recent action. 

1.13.3  Temporarily Hide a Chart Feature 

To temporarily hide a ​Chart Feature​, either: 

● Right-click on the feature itself in the ​Outline ​view and untick ​Visible​, or 
❏ 

● Click on the feature in the ​Outline ​view and, in the ​Properties ​view, change the 
Visible ​attribute to ​No​. ❏ 

1.13.4  Remove a Chart Feature 

To remove a ​Chart Feature​, in the ​Outline ​view: 
1. Click on ​Chart Feature​ to expand it. Right click on the Chart Feature that you want 

to delete. ❏ 
2. In the pop-out menu, select ​Delete [feature]​. The feature will be removed from the 

Outline ​view and the​ plot editor​. ❏ 
An example is shown in the below screenshot. 
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That concludes this part of the “​Getting Started with Debrief​” tutorial, either go over it again until 
you’re happy with everything covered, or use it as an aide-memoire and refer to it as needed. Next, 
proceed with the “​Working with Debrief​” tutorial. 

 

 

Signed: ________________  Date: ___________________ 
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2.  Working with Debrief NG 
In this tutorial, we’re going to cover how we are going to work with ​Debrief ​and, in particular, defining 
workspace and viewing data. These two are essential to building your knowledge before moving to 
analysis tasks. Now let us learn all about viewing and working with data in ​Debrief​: 

2.1  Working with Data 
In this, the second section of the ​Working with Debrief​ tutorial, we will first look at the following areas:  

● Creating a New Plot 
● Adding Data to a Plot 
● Editing Data 
● Analysing Sensor Data 

2.1.1  Creating a New Plot 

This tutorial will guide you through creating a new, blank plot in ​Debrief​. 

Check you have a Project 

Plots are stored in projects, so before you create a ​plot​, you must have a ​project​. If you don’t have 
one, refer to ​Generating a Project for Your Data​ and follow the steps there. 

Create New Plot 

To create a new ​plot​, in the ​Navigator ​view: 

1. Right-click on the parent folder for your new plot and select ​New > Debrief Plot​; the 
Create new Debrief Plot ​wizard will open. ❏ 
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2. Next, either confirm where you would like the plot to be stored—this is called the 
plot’s container​—or select a different location by first clicking on the ​Browse 
button and then selecting the parent folder of your data directories. 

 
 

❏ 
3. Change the filename (as required). ❏ 
4. Click on ​Next​. The ​Add Vectored background data​ will display. ❏ 
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5. Now, select/deselect whether to use the ​Natural Earth dataset​; click on ​Next​. the 
Add Scale to Plot​ wizard will display. ❏ 

 

6. Now you can choose whether to ​Add Scale to Plot​, or not; including the following 
options: ​color​, ​display units​, and ​scale location​. ❏ 
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If you select to include a scale, you must enter the ​display units​ and ​scale location​ to 
proceed to the next step. The ​Add Coastline to Plot​ wizard will be displayed. 

 
❏ 

 

7. Next you can choose whether to​ ​include a coastline or not. This option is not 
mandatory. ❏ 

8. Click on ​Next. ​The ​Add Grid to Plot​ dialog will be displayed. 
 ❏ 
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9. Here you can select whether to include a ​grid​, the ​grid color​, whether to show ​Plot 
Labels​, and the ​Delta—grid step size​. ❏ 

10. Click on the ​Finish ​button. The changes will be applied, and the dialog will 
close. ❏ 

Finished 
Your new plot (with the filename you used earlier) will then display within your ​Debrief ​window. It is 
also located in the folder you specified in step 2 (above). 
Note​: All wizards make things easier for us, but all the steps above can be performed from the ​Chart 
Features​ menu in ​Debrief ​(​Alt,C​). 
 

2.1.2  Adding Data to a Plot 

Debrief​'s ​New Plot​ wizard is effective at providing you with a preformatted backdrop to your analysis, 
but it doesn't load your data for you. We will now load some existing tracks to assist you in getting 
started. 

Check Sample Data 

To check sample data: 

1. Open the ​Navigator ​view (using your mouse, or press ​Ctrl+3​ and type the search 
term). ❏ 
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2. Expand the folder that contains your existing ​Debrief ​files (these will be either REP 
or DPF). 

 

❏ 

Note​: Valid ​Debrief ​files are flagged with a ​Debrief ​icon. Refer to the ​Debrief File Formats​ chapter in 
the ​Debrief User Guide​ to learn more about the two file types. 

Drag in a Simple Track 
 
If you've already got a plot open, close it now by clicking on the cross in the small 
tab-shaped icon above it. Don't worry about saving the tutorial files. Drag a ​rep ​track 
from your ​Navigator ​onto the blank plot area. The​ “boat1.rep”​ file is a simple starting 
point. The plot and any associated views will promptly update. When rep files are 
dragged in, you may be asked whether you wish to import the data in ​Over The Ground 
(OTG)​ or ​Dead Reckoning (DR)​ mode. For this tutorial, select ​OTG​. 
 

 
 
 
 
 

❏ 

 
The plot for ​boat1.rep​ will be as shown below: 

 
DebriefNG Tutorials 

www.debrief.info Page 60 of 116 

http://www.debrief.info/tutorial/index.html#reference.html
http://www.debrief.info/


Introduction to Debrief 

 

 

Drag in a Complex Plot 

If you have multiple tracks to analyse, you can drag them onto the track plot you've just created. But for 
now, close the plot you have opened by clicking on the cross icon in its tab and press ​Don't Save​ when 
prompted. 

Now, drag “​sample.dpf” ​into the plot area. You'll see that this plot contains more complex graphical 
features. 
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Debrief File Types 

Note:​ You've just encountered two file types, the ​Replay ​file type (.rep ) and the ​Debrief ​file type (.dpf). 

 

The two file types differ in that though the ​.rep​ file format is a very simple, column oriented text format 
ideal for passing around track data and for getting your raw track data into ​Debrief ​(see the ​Reference 
section ​in the user manual for more details), it isn’t suited to storing formatting data or user preferences; 
in contrast, with its textual XML structure and ability to store a wide range of data, the ​.dpf​ file format is. 

As such, a typical flow is that data enters ​Debrief ​in ​.rep​ format and an analyst uses this data to 
create a custom plot; this plot is then stored in XML format as a .dpf file. 

Your track data is now on the plot. ❏ 
Note​: Tracks can be dragged into ​Debrief ​from other areas, such as “​Windows Explorer​”. Refer to the 
Maintainer’s Guide​ section of the ​Debrief User Guide​ to learn how to support right-click track opening 
on MS Windows. 

2.1.3  Editing Data 
Check you have data 

To check that you have data: 

1. As before, open ​Navigator ​if it is closed (​Ctrl+3 ​then clicking on ​Previous Choices​, 
or typing in ‘navigator’ into the search field and clicking on it when it appears). ❏ 

2. Confirm you have sample data-files in the ​Navigator ​view. If not, refer to the 
Viewing Data​ tutorial. ❏ 

Open the sample plot-file 

Double-click on “​sample.dpf”​ in the ​Navigator ​view; the sample plot will open. ❏ 
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Fit to Window 

You can also experiment with zooming in and out. Click the ​Zoom Out​ button once to zoom out, or you 
can put the plot into ​Zoom In Mode​ by clicking on the​ Zoom In​ button. Now, when you drag an area, 
the map will zoom in on that viewport. 

 

Lastly, to make sure all of the data is visible, click on the ​Fit-to-Window​ toolbar button. You can read 
more about the toolbar buttons in the ​Moving Around the View​ section of the ​Debrief User Guide​. 

Note​: if you hover your mouse cursor over any button, a tooltip explaining its function will display. 

Ensure the Properties view is open 
 
The ​Properties ​view is normally at the bottom left of ​Debrief​. If it's there but not at the 
top of the 'stack', click on its tab to reveal it. If you can't find it, select ​Properties ​from 
the ​Window > Show View​ drop-down list (​Alt,W,V,P​). 

 

❏ 
Select an Item 
 
You can select an item on the plot by double-clicking on it. 

1. Identify the chart feature named ​Some Label​, in the plot of ​sample.dpf. ​ To the 
right of it is a red circle. ❏ 
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2. Double-click on the circle to select it. In the ​Outline ​view, you will see that the object 
Label:Some Label​ has been selected (Fig a. Shown below) and, in the ​Properties 
view, you can see that the properties for the object you selected are listed (Fig b. 
Shown below), including ​Color​, ​Font​, ​Location​, etc. 

 
 
 

❏ 

 
                              Fig a.                                                                       Fig b. 

 
DebriefNG Tutorials 

www.debrief.info Page 64 of 116 

http://www.debrief.info/


Introduction to Debrief 

 

3. Now, double-click anywhere on the ​NOGO DELTA​ rectangle to select that feature. ❏ 
Make a Change 

To change the rectangle's label color: 

1. Click once on the green rectangle next to​ Label color​, under the ​Properties ​view. A 
button containing an ellipsis will appear. 

 

❏ 

2. Click on the ellipsis to open the ​color editor​. ❏ 

3. Next, select the red color, and then click on the ​OK ​button. ❏ 
The dialog will close, the label color property will be updated, and the plot will redraw. 

Undo the Change 

Our new color doesn't meet the ​“NATO MilStd 12332 Sub-para 14g (2002 version) standard”​, so we 
need to undo it: 

1. Click on the tab at the top of the ​sample.dpf​ plot to select it ❏ 

2. Click on the ​Edit ​menu. ❏ 

3. Select ​Undo NOGO DELTA Label Color​. ❏ 
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The color of the label will now change back—you’ve undone 1 step. 

Now that you’ve undone an action, if you click on the ​Edit ​menu again, you'll see there's 
now a ​Redo ​option available. This undo/redo feature is common to most programs and 
can be applied to many functions; the shortcut keys for these are ​Ctrl+Z ​and ​Ctrl+Y​, 
respectively. 

 
 

❏ 
Note:​ The ​Undo ​button applies to the active Debrief view; so, to undo a change to a plot, you must 
first select the plot and make it ​active ​before pressing undo. 

2.1.3.1  Edit a Position 
To select a position within a track, double-click on that position and its editable attributes 
will appear in the ​Properties ​view. You can modify all of these attributes (as required). 
In this example, I have selected the track position ​0600​ (highlighted within the red 
rectangle) and its properties are shown in the ​Properties​ view. 

❏ 
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Note​: different elements have different properties, so you may have to scroll up and down the 
Properties ​view to see all available properties. 

2.1.3.2  Edit an Entire Track 

To edit an entire track, we use the ​Outline ​view. This makes selecting a plot easy. To open the ​Outline 
view: 

1. Click on ​Window > Show View > Outline View​. ❏ 

2. In the ​Outline ​view, click once on the name of a track and the entire track's 
properties will be editable in the ​Properties ​view. ❏ 

 

The ​Outline ​view is also useful for selecting and editing non-geographic entities such as a grid, scale, 
or background data-set. 
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Note​: To learn how to rearrange view, refer to the section ​Moving Views​. 

2.1.3.4  Edit Directly from the Plot  
It’s possible to edit certain attributes by right-clicking on an item on the plot. A popup menu will display 
showing a series of available options and commands. A drop-down menu is shown next to the current 
item's name and, from this drop-down menu, you'll be able to edit the respective attributes. For 
example, right click on the item ​BARRIER CHARLIE ​and the drop-down menu will display. 

 

Note​: if you click on a vehicle position, a drop-down is shown for the parent track as well as the 
position itself. Also, remember that right-click functionality is available from anywhere within the 
program, and relevant options will be shown related to the tasks or actions you are currently 
undertaking. 

Don't forget to save 
Anyone who has used computers for any length of time will have lost work at some 
point, so ensure you save your work regularly. You can save your work quickly by 

clicking on the floppy-disk icon on the main toolbar or by pressing ​Ctrl+S​. Do this 
now. 

❏ 

Note​: if the data you're using is actually a ​.rep​ file, these cannot store formatting data, so you will be 
prompted to save the file in  ​.dpf​ format. 

2.1.4  Analysing Sensor Data 
Check You have Data 
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To check that you have data: 

1. Open ​Navigator ​(using your mouse, or ​Ctrl+3​ and typing ‘navigator’) ❏ 
2. Confirm you have sample data-files in ​Navigator​. If not, refer to the ​Finding the 

sample data​ ​tutorial. ❏ 
Opening the Sample Sensor Tracks File 
 
To open the sample file, double-click on the “​sen_tracks.rep”​ file. The file will then load. 
If the ​Import ​dialog appears, select ​Over The Ground (OTG)​ for both tracks, you will 
see the red and blue vessel tracks. 

❏ 

 

Fit to Window 
 
The workspace can get cluttered quickly, so to make sure all of the data is visible, click 
on the ​Fit-to-Window ​button on the​ ​toolbar. 

❏ 
Adding the SSK Track 
 
We will now add the sensor data. Starting from the ​Navigator ​view, drag the 
“​sen_ssk_sensor.dsf”​ SSK sensor data file onto the plot. The ​Import Sensor data 
wizard will display.  

❏ 
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Accept the default options in the wizard and click ​Finish. 
 
Note​: The data will be imported, but there will not be any visible change to the plot area. 
Since very high volumes of sensor data are typically loaded, sensor data is hidden by 
default. 

❏ 

Adding the FF track 

Next, drag the “​sen_frig_sensor.dsf”​ frigate sensor data file onto the plot. ❏ 

 
Note​: The data will be imported, but there will not be any visible change to the plot area. 
Since very high volumes of sensor data are typically loaded, sensor data is hidden by 
default. 
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Viewing the Sensor Data 

To view the sensor data, in the ​Outline​ view: 

1. Expand the tree for the two tracks called ​Frigate ​and ​New_SSK​. Within each of 
these tracks, you will see named blocks of sensor data. ❏ 

 

2. Now, we need to make each block of sensor data visible, so click on it to select it 
and then click on the ​Reveal Selected Items​ toolbar button. As you make each set 
of data visible, you should see its bearing fan appear in the plot area. Overall, there 
are six blocks of sensor data across the two tracks. 

 
 
 

❏ 

 

2.1.4.1  Sensor Formatting Options 
Sensor lines can be formatted to change their color, their label, and location. This 
formatting can be applied to a single sensor line or a series of sensor lines. For ❏ 
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example, change the color and label of the of th sensor line ​Sensor:Frigate Optic5 (6 
cuts). 

 

2.1.4.2  Format Sensor Data 
Next, we will simulate formatting a series of bearing lines to represent the state of a particular sensor. 
In the ​Outline ​view: 

1. Click on the arrow next to ​Track:New_SSK​, then on​ ​the arrow next to ​Sensors (1 
items). ​The sensor bearings will display. ❏ 
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2. Select the first five sensor bearings by first left-clicking on the top sensor bearing; 
and then, with the ​Shift ​key pressed, click on the 5​th​ sensor: all 5 items should be 
selected. 

 

❏ 
3. Switch to the ​Properties ​view. This should show the editable properties for those 

bearings. ❏ 
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4. Click on the ​Color ​property, and select ​yellow​. Click ​Ok​. ❏ 
You will see the sensor lines on the plot update. 
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2.1.4.3  Conduct a Plot-Lock 
We will now simulate the process of dragging tracks so that their bearing fans match. In the UK this 
process is called a ​plot-lock​, and in the US it’s called a​ tie-point​. 

Firstly though, we must indicate which tracks we want to view the relationship between: 

1. Right-click on ​Track:Frigate​ and then select ​Make Primary​. 
 

 

❏ 

2. Right-click on ​Track:New_SSK​ and select ​Make Secondary​. 
 ❏ 
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These will both appear in the​ Track Tote​ view. 

 

2.1.4.4  Commence Plot-Lock 
 

To commence plot-lock, click on the ​Drag Track Segment​ button on the Main 
Toolbar.  

 
❏ 

2.1.4.5  Start Dragging 
 
The ​Bearing Residuals​ ( also known as the ​Stacked Dots ​view​) ​view will display and the cursor will 
be changed to a brown hand. 
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The ​Bearing Residuals​ view shows the bearing error for visible sensor bearing lines 
against the point on the target track nearest to that DTG. 

❏ 
When the cursor is over a track, it will turn green. ❏ 
1. Click on the ​Drag Whole Feature​ button  on the Main Toolbar.  
2. In the ​Plot Editor​, move the cursor over the north-west end of the blue track until the 

cursor turns green. ❏ 
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3. Hold down the mouse button and start dragging the track. ❏ 
You will see the track and its sensor data start to hover as you drag it and, once you have finished 
moving the track, the bearing errors in the​ Stacked Dots​ view will update accordingly. When 
plot-locking tracks, your aim is to minimise the errors displayed on the graph. If you value some 
sensor data more than others, experiment with hiding the other blocks of sensor data (by making them 
invisible)—this will declutter the plot and the stacked dots, making plot-locking easier. 
 
Done 

Well done! You’ve completed the steps on loading, managing and formatting sensor data—supported 
by a healthy dose of plot-locking. Having come this far, you now know the initial steps of using ​Debrief​. 
Sure, you’re a way off mastery, but that comes with a bit of practice, so be sure to run through the steps 
above again. 

You now know about the views and how we can use them to our advantage, so it won’t take you as 
long the next time. 

Now we’ll move on the next tutorial, ​Controlling what you view​, where you’ll start using the analysis 

features of ​Debrief​. 

 

Signed: ________________  Date: ___________________ 
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3  Controlling What You View 
This tutorial will get you started with some of the analysis functionalities within Debrief which include the 
following: 

● Filtering your View 
● Assessing Primary and Secondary Tracks 
● Viewing Time-related Vessel Tracks 
● Analysing Time-related Calculated Data 
● Narrative Data 

3.1  Filtering your View 
Ever-increasing data rates from multiple recording systems means your analysis plot will quickly 
become swamped. This tutorial will show you how to manage the volume and type of data displayed 
using Debrief NG’s tools. We will be covering the following areas in this section: 

● Viewing the Entire Data Plot 
● Hiding Shape 
● Hiding Entire Layer 
● Filtering to a Time Period 

Open Navigator 
You will need to have the ​Navigator ​view open, so if it isn’t visible, open it now (refer to 
the previous tutorial if you’re still unsure on how to do this). ❏ 
Open a Sample File 
Now, double-click on​ “sample.dpf”​ in the ​Navigator ​view and the sample ​Debrief ​plot 
will open. ❏ 
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View the Entire Data Plot Area 
To ensure you can see all of the data, click on the ​Fit-to-Window​ button either on the 
main toolbar or in the ​Chart Overview​ view toolbar. ❏ 
Open the Outline View 
You will need the ​Outline ​view for this exercise, so if it isn’t already open, open it now 
by either clicking on ​Window > Show View > Outline​, or by using the shortcut key 
Alt+Shift+Q,O​. 

❏ 

3.1.1  Hiding a Shape 

At the top of the ​Outline ​view is a toolbar of operations that can be applied to plot items. 

● In the ​Outline ​view, you can see a list of items, including one called ​Misc (5 
items)​. Click on the arrow to the left of it and the group will expand. 

 
❏ 

● Select any item within that group and then click on the empty rectangle button in 
the ​Outline ​view toolbar (next to the ​+2​ button). You will see that the tick next to 
the element and the corresponding shape on the plot disappear. 

 

 

❏ 

 
DebriefNG Tutorials 

www.debrief.info Page 80 of 116 

http://www.debrief.info/


Introduction to Debrief 

 

 

● Finally, another way of doing this is to right-click on an item. and  select the item 
name and tick or untick the field ​Visible​, as required. 

 

❏ 

Note​: You can show/hide more than one item at a time by holding down the ​Ctrl ​key and clicking on 
multiple items. 
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3.1.2  Hiding Entire Layer 

Next, experiment with hiding the whole layers.  To hide an entire layer, you can either: 
 

● Select one of the tracks in the ​Outline ​view and click the ​Hide selected items​ box 

in the ​Outline ​view toolbar.  

 
❏ 

 

● Right click on the layer that you wish to hide and click the layer name and then 

untick ​Visible. 

❏ 

 

Note​: You can expand each track to see the series of positions within. Once expanded, you can select 
a series of points (each of which represents a time-period) to be hidden/revealed. However, this is just 
one way of doing it. 

 
DebriefNG Tutorials 

www.debrief.info Page 82 of 116 

http://www.debrief.info/


Introduction to Debrief 

 

3.1.3  Filtering to a Time Period 

We will now filter the plot to a particular time period. 

1. Open the ​Time Controller​ (​Window > Show View > Time Controller​) and click on 
it. You can see that the lower section of the Time Controller consists of a pair of 
sliders used to mark the start and end time of a variety of tasks. 

 

❏ 

2. Click ​View Menu​ ( ) and select ​Filter to period​. ❏ 
 

 
 

3. In the time period markers (the part underneath the ​Time Controller’s slider​), drag 
the start and stop markers to different positions. In the following example, the 
starting marker is at 120700 and ending marker is at 120947. 

 

 

❏ 
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As you do this, you’ll see the shaded portion adjust to the selected period: this represents a 
custom time period and is visible on your plot. You can drag this shaded section to move 
your ​windows​ forwards and backwards. 

 
 
 

❏ 
If you hold down the ​Shift ​key while you move elements on the time plot, they will ​snap​ to 
the hour lines. 

 

❏ 
Note​: Before you either close the file or go onto the next tutorial, drag the time sliders back 
to their start and end positions. ❏ 

 

Hopefully you found the above steps easy to follow. Controlling what you are viewing is an essential 
component of working effectively with ​Debrief​, and an essential skill for both data analysis and collation 
of information for transfer to presentation applications like MS Word or MS PowerPoint. 

3.2  Assessing Primary and Secondary Tracks 

In the next part of the tutorial, we will look at what are termed as primary and secondary tracks. These 
are not standard terms, but are used to specify or determine the relationship between tracks in ​Debrief​. 
The primary track is always the track that is the focus of attention, with calculations involving secondary 
track(s) performed relative to it. All these calculations are shown in a view called the ​Track Tote​. In this 
tutorial, we will look at setting up primary and secondary tracks, moving tracks through time, etc. So, we 
will be looking at the following areas in this section: 
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● Viewing Track Tote 
● Understanding Track Tote 
● Moving Track through Time 
● Removing a Track from Tote 
● Adding a Track to Tote 

Open Navigator 

If the ​Navigator ​view isn’t visible, open it. ❏ 

Open the Sample Plot File 
If you closed the ​sample.dpf​ file at the end of the last exercise, locate it in the 
Navigator ​view and double-click on it to open it again. ❏ 

Fit to Window 

To make sure all of the data is visible, click on the ​Fit-to-Window​ toolbar button. ❏ 

3.2.1  Viewing Track Tote 
In the centre section of the left hand column in Debrief is the ​Track Tote​. If it's not 
visible, open it by clicking on​ Window > Show View > Track Tote​. ❏ 

However, if it's just obscured by other view panels, click on its tab to bring it to the front. ❏ 
3.2.2  Understanding Track Tote 

The ​Track Tote​ contains information about selected tracks within the active plot. Though the actual 
limit on the number of tracks that can be displayed is determined only by the memory capacity or 
capability of your system, the ​Track Tote​ itself will display a minimum of at least two columns: 1 for the 
active track​ and 1 for the ​Attribute column​ (an optional ​Units column ​can be added, if required). 

In our ​sample.dpf ​example, the left-side track column contains the primary track data for ​Nelson ​and 
the right-side column contains the secondary track data for ​Collingwood​. All calculation data is taken 
from the corresponding track (the calculations themselves are explained in greater detail in the ​Debrief 
User Guide​). 
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3.2.3  Moving Track Through Time 

Now we will use the ​Time Controller​ to change the time. 

1. If the ​Time Controller​ is not visible, open it. ❏ 

2. Drag the ​time-slider​ right and left, and you will see the calculated data fields update 
(you will also note the vessel positions on the plot—the white squares—also move). 

 
 
 

❏ 
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3.2.4  Removing a Track from the Tote 

Now we will remove the Collingwood secondary track from the tote: 

1. Right-click on any of the cells in the ​Collingwood ​column. ❏ 

2. Select ​Remove this track​ from the drop-down list. ❏ 

 

The ​Collingwood secondary track​ will be removed, leaving the one remaining ​Nelson ​track. 
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3.2.5  Adding a Track to Tote 

To add a track to the tote: 

1. Open the ​Outline ​view - Take note of the '​1​' and '​2​' buttons on the view's toolbar, as 
they're currently disabled. 

 

 

❏ 

They will become enabled when a currently selected item is suitable for inclusion on the tote. 

2. Click once on the track you just removed from the tote (​Track:COLLINGWOOD​) 
and both buttons will be enabled. You can now make the current track as primary or 
secondary. 

❏ 
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3. Make your choice now and assign it as either ​primary ​or ​secondary​. As you do so, 
it will appear in the tote once more. ❏ 

Note​: Any data-item that has time and location attributes can be placed on the tote (not just tracks): 
Items such as circles and labels are particularly suited. 

Note​: The next tutorial also uses the ​sample.dpf​ plot, so if you plan to continue now, you can proceed 
with that; if you don’t, close it and don’t save any changes. 

3.3  Viewing Time-related Vessel Tracks 
Debrief ​offers more than just a static overview of vessel tracks and it also allows you to control the time 
period of data shown. We will be looking at the following areas in this section: 

● Moving Slowly Through Data 
● Moving Quickly Through Time Period 
● Experimenting with Time Formats 
● Changing Plotting Modes 
● Working with Time Periods 
● Selecting Precise Time 
● Time Controller’s Editable Properties 
● Bookmarking the Current Time 

Open Navigator 

If the ​Navigator ​view isn’t visible, open it. ❏ 

Open the Sample Plot File 
If you closed the plot earlier, double-click on​ “sample.dpf” ​in the ​Navigator ​view, and 
the sample plot will open. ❏ 

Fit to window 
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To make sure all of the data is visible, click on the ​Fit-to-Window ​toolbar button. ❏ 

3.3.1  Viewing the Time Controller 
We looked at the ​Time Controller​ in the​ Filtering your view​ tutorial previously. So if it’s 
not currently visible, open it. ❏ 

Confirm You’re in Normal ‘Stepping Mode’ Time 

The ​Debrief Time Controller​ has 2 time stepping modes: ​Normal Mode​ and ​Snail Mode​. Buttons for 
these modes are located on the view toolbar: 

1. Normal Mode​ shows all exercise data. 

2. Snail Mode​ shows the current position and recent points, and is used for detailed analysis around a 
specific time. 

 

● Click on the left-most button to select ​Normal mode​. ❏ 

3.3.2  Moving Slowly Through Data 

Above the current time indicator, are a series of button controls similar to the pause/play/rewind buttons 
you'd find on any music or DVD player.  

 

● Click on the buttons and you'll see the green date and time value adjust accordingly; 
also note the movement of the white rectangular highlight along the vessel tracks to 
denote the vessel position at that time. 

 

❏ 

3.3.3  Moving Quickly Through Time Period 
● If you want to move quickly through the time period, drag the time-slider in either 

direction and see how quickly the white rectangular highlight moves along the vessel 
tracks, as well as the time change shown in the ​Time Controller​ view. 

 

❏ 
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● In addition, if you also have the ​Track Tote​ view open, notice how it's updating to 
reflect the current time.  ❏ 

3.3.4  Experimenting with Time Format Options 

The ​Time Controller​ also has a drop-down menu at the end of the toolbar. Within this drop-down are 
additional sub-menus, including ​DTG Format​, where you can select the format in which the current 
time is displayed, and ​Time Slider Increment​, where you can adjust the time increment used for 
moving through the plot. 

1. Change the​ DTG format​ so that you can see the full Year/Month/Day for the current 
DTG. 

 

❏ 

 

2. Next, change the ​time slider increment to 15 minutes​, so that you can move 
through the plot much quicker ❏ 

 

3.3.5  Changing Plotting Modes 

To change plotting modes: 

1. Within the ​Time Controller’s​ drop-down menu, click on​ Plotting Mode​. ❏ 
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2. Select ​Primary Centred/North Oriented​. ❏ 

3. Click on the​ Snail mode​ button . ❏ 
4. Now, move the slider forwards and backwards and watch the plot change. ❏ 

Note​: The ​Plotting Mode​ is selected independently of the mutually exclusive ​normal ​and ​snail 
Display Modes​. 

3.3.6  Working with Time Periods 

Now we’ll look at the time period selector within the ​Time Controller​. Though it is used to select a 
period of time, it doesn’t function in quite the same way as the other controls do. You see, when you 
change the other controls, you see something happening because it’s affecting current operations; 
whereas when you change the time period, you’re changing the period that will be used for subsequent 
operations. 

For example: 

1. Select a time period of ​120700 to 121000​. ❏ 

2. From the ​Time Controller's​ drop-down menu, select ​Export calculated data to 
clipboard​. The 3-hour's worth of calculated data from this selected period has just 
been copied to your system clipboard. You can now paste that into your preferred 
analysis software, such as MS Excel. 

 
 
 

❏ 
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3.3.7  Selecting Precise Time  

It can be difficult to select precise times using the slider, but there is another way: 

1. Double-click on the start/finish time marker triangle - the value will then become 
editable in the ​Properties ​view (below the ​Time Controller​). ❏ 

 

2. Modify the ​time value ​and then click away from the property to enter the value. ❏ 
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Or, if you're just trying to move the time value a very small amount: 

1. Press the ​Ctrl ​key on your keyboard. ❏ 

2. Double-click on the​ start/finish marker​ to display a ​mini time-slider​. ❏ 

 

 

3. Adjust it to the time you require, then click away to enter this time value. ❏ 
3.3.8  Time Controller's Editable Properties 

As we’ve already seen, the​ Time Controller'​s drop-down menu contains a series of sub-menus. 
Some of these sub-menus have an ​Edit properties​ element, which lets you control various aspects of 
temporal data analysis. 
For example, once you've selected an item from the properties drop-down menu, its 
attributes will then become editable in the ​Properties ​view (open it if it's not visible). ❏ 
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Note​: The item only appears in the ​Properties ​view if the ​Time Controller ​is the ​active view​. 
Remember, the currently active window or name tab is highlighted blue. If it isn’t selected, click on the 
tab to do so. 

3.3.9  Bookmarking the Current Time 

Debrief NG​ lets you insert a bookmark attached to a particular DTG in the current plot. This is useful 
if, let's say, if you're analysing a particular exercise and want to record some interactions. 

1. In ​Normal view mode​, move the ​time-slider​ to ​121011 ​hrs - this is the point when 
RED/NELSON​ detects ​BLUE/COLLINGWOOD ​and reacts. ❏ 

2. Select ​Add DTG as bookmark ​from the ​Time-Controller's​ drop-down menu.  ❏ 

 
 

A dialog box will open prompting you to enter a description for the DTG Bookmark. 
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3. Enter ​First contact​, then press ​OK​. ❏ 
4. Now, move the ​time slider​ to ​121129​. ❏ 
5. Select ​Add DTG as bookmark ​again and enter a bookmark title ​Plotlock start​. ❏ 

Though you’ve now entered these bookmarks, they won’t be visible until you show the ​Bookmarks 
view. To view the Bookmarks: 

1. Click on ​Window > Show view > Bookmarks​. ❏ 

 

2. Now, double-click on either ​bookmark ​to move to that time. ❏ 
3. Save (​Ctrl+S​) and close your plot. ❏ 

Note​: You can store as many bookmarks as you like, and all stored bookmarks can subsequently be 
accessed and used across all your analysis plots, even if a different plot is being edited. 

Done 

If you found the above tutorial easy, then great! Not only is the ​Time Controller​ a very capable panel 
that provides a wide range of functionality, but it’s also one of the more complex parts of Debrief. So, 
once you’ve conquered that, you’re making great progress. 

Note​: We use the ​sample.dpf​ plot again in the next tutorial, so if the time sliders are not 
at their start and end positions, please adjust them now. ❏ 

3.5  Analysing Time-related Calculated Data 
Debrief ​is capable of producing analytics far beyond the traditional graphical track plots; all it needs is 
data. The most obvious derived products are the analysis plots - graphs showing time versus either a 
recorded data value or a calculation based on a specific set of data-values. In this tutorial we will look 
at how to do just that. We will be looking at the following areas in this section: 
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● Selecting Required Tracks 
● Opening xy-plot 
● Navigating Around Plot 
● Measuring Range and Bearing 
● Tracking Other Objects 

3.5.1  Process Overview 

To be able to analyse the data correctly, we first need to tell ​Debrief ​what information is required, 
such as: 

● the time period we want plotted 
● which participants to plot data for 
● what type of data to plot 
● which is the primary track (for relative calculations). 

But, before we can do that, we need the data; so, as always... 

Open Navigator 

If the ​Navigator ​view isn’t visible, open it. ❏ 

Open the sample plot-file 

Double-click on ​“sample.dpf”​ in the ​Navigator ​view and the sample plot will open. ❏ 

Fit to window 

To make sure all of the data is visible, click on the​ Fit-to-Window ​toolbar button. ❏ 

Open the Time Controller 

As we said in step 1, one of the attributes we need to specify is the time period; and, to do that, we 
need the ​Time Controller​. 

If is isn't open, click on ​Window > Show View > Time Controller​. ❏ 

Select the required time period 
Now we need to select the required time period: adjust the start and end markers to 
select the period ​120800 ​to ​121100 ​respectively. ❏ 

Note​: Remember, holding down the ​Shift​ key makes the sliders snap to the hour markers. 

Open the Outline View 
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Next, we need to indicate what tracks we want to see information for. In the bottom left 
hand corner of ​Debrief ​you should find the ​Outline ​view. If it isn't visible, click on 
Window > Show View > Outline​. 

❏ 

3.5.2  Selecting Required Tracks 

In the ​Outline ​view: 

1. Click on ​Track:COLLINGWOOD​ track to select it. ❏ 

2. Then, holding down the ​Ctrl ​key, click on ​Track:NELSON​ track to select that also. ❏ 
3.5.3  Opening the XY-plot 

Now we will open the xy-plot: 

1. Right-click on the selected items and, in the drop-down menu, click on ​View XY Plot​. ❏ 

 
2. The ​View time-variable plot ​dialog will open; select ​Range ​from the available 

attributes. ❏ 
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3. Click on ​OK ​and the​ Select primary​ dialog will open. ❏ 

 
4. You must designate either ​Track:COLLINGWOOD​ or ​Track:NELSON​ as the 

primary track for this plot. For this example, select ​Track:COLLINGWOOD ​and click 
OK​. 

❏ 
As ​Debrief ​calculates the data and relationships between multiple tracks, it needs to know which track 
is the primary subject to be able to do this. 

5. The ​Collingwood Range v Time plot graph​ will display. ❏ 
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3.5.4  Navigating Around the Plot 

To navigate around the plot area: 

● Zoom in​ - To zoom in on the graph, click on the top-left corner, hold down the mouse 
button, drag it to the bottom-right corner and release the mouse or right-click on the 
graph and select​ Zoom in >[Both Axes | Domain Axis | Range Axis]​) 

❏ 

● Zoom out​ - To zoom out of the graph, click on the bottom-right corner, hold down the 
mouse button, drag it to the top-left corner and release the mouse or right-click on the 
graph and select ​Zoom out >[Both Axes | Domain Axis | Range Axis]​). 

❏ 

Alternatively, another method of zooming out is to click on the... 

● Fit to Window​ button - you’ve already used this before. ❏ 

Customisable 

In addition, you can also experiment with the other commands present on the view toolbar, and even 
configure and customise the graph to use your preferred fonts and titles. 
1. On the ​xy-plot ​view toolbar, either click on the ​Change Editable Properties ​button 

 or click on the view’s drop-down menu and select ​Configure plot​; the ​Chart 
Properties​ dialog will display. 

❏ 
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Note​: ​Properties ​view must be open to see the chart properties. 

2. Now, in the ​Title Text​ field, change the title to ​Collingwood vs Nelson - Calculated 
Range​. ❏ 

 

 
3. Click away from the ​Title Text ​field to see the change. You will see the graph title 

update. ❏ 
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3.5.5  Measuring Range and Bearing 

As you’ve seen, you can perform a number of functions in the ​Range vs Time ​plot graph, but there is 
another way to measure range and bearing, and that’s using the ​Measure range bearing ​button. This 
option is much quicker as you don’t have to go to the trouble of designating primary and secondary 
tracks. In addition, this option also allows you to measure the range and bearing between any 2 points 
on the plot editor. To do this: 

1. On the ​Main toolbar​, click on the ​Fit to window​ button. ❏ 

2. Still on the​ Main toolbar​, click on the ​Measure range bearing​ button.  ❏ 

3. Now, in the ​plot editor​, left-click and hold on the point you wish to measure from. ❏ 
In this example, click on the bottom left corner of the green ​NOGO DELTA ​rectangle (it 
doesn’t have to be exact, this is purely for illustrative purposes).  
4. Drag the mouse to the point you wish to measure ​to​, which in our case is the NW tip 

of the white​ other line ​object. ❏ 
As you drag the mouse, you will see the calculated results appear in the mid-point of the connecting 
objects as well as in the bottom right of the plot editor status bar (mine shows ​6.09 nm 153°​ at the tip of
the white line). This will remain there until you click elsewhere in ​Debrief​. 
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5. If you release the left mouse button, though the line and results will disappear from 
the editor, the results will still show in the status bar.  

 

However, if you don’t release the left mouse button and right-click at your destination 
point, you will see a pop-out menu with a number of options. 

 
 

❏ 
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6. Either select the option you require, or you can press the ​Esc ​key on your keyboard 
to close the pop-out menu and leave the measured range and bearing on the plot. 
This plot line will disappear if you perform some other function in ​Debrief​. 

 

❏ 
3.5.6  Tracking Other Objects 

Other objects as well as tracks can be plotted, such as tracking the proximity of multiple vessels to a 
fixed point object (such as a sensor). To do this: 

1. Insert a label annotation on the plot by clicking on ​Drawing > Label​.  ❏ 

 
 

The ​Adding a new Drawing Feature​ dialog will display. 
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2. Select ​Annotations ​and click ​OK​. ❏ 
3. In the ​Properties ​view, rename the label to ​Sensor 1​. ❏ 

 
We will now move the sensor to a new position. 

4. Press ​Alt+3​ on your keyboard to select the ​Drag Whole Feature​ option, and the 
mouse cursor will change to a brown hand. ❏ 

 
DebriefNG Tutorials 

www.debrief.info Page 105 of 116 

http://www.debrief.info/


Introduction to Debrief 

 

5. Move the mouse over​ Sensor 1 ​until the hand changes to green. Now you can move 
the sensor. ❏ 

6. Drag and drop it to wherever you wish on the plot; somewhere close to the 2 tracks 
perhaps. ❏ 

Now, in the ​Outline ​view, if it is not selected, click on ​Sensor 1​. ❏ 

7. To select all the tracks, press ​Ctrl​ on the keyboard and click on the tracks ​Label: 
Sensor 1​, ​COLLINGWOOD, ​and ​NELSON​.  Right-click and select ​View xy plot. ❏ 

 

The ​View time-variable plot ​will display.  ❏ 
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8. Select ​Range​ and click ​OK​. The ​Select primary​ dialog will display. ❏ 

 

9. Select ​Label:Sensor 1​ as the primary track and click on ​Ok​. ❏ 
You will now see the ​Sensor 1 Range vs Time plot​ showing how close the vessels came to the 
sensor and at what times. 

 

Remember, this plot is constrained by the time period selected in the ​Time Controller​. Let’s extend 
this now. 
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1. Drag the time sliders to the full exercise time period (​0500 - 1145​). ❏ 

 
2. In the ​Outline ​view, select the tracks ​Label: Sensor1, Track:COLLINGWOOD, 

Track:NELSON​ and right-click and select ​View xy plot​. ❏ 

 
 
The ​View time-variable plot ​dialog will display. 
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3. Select ​Range ​and click ​Ok​. ❏ 

The ​Select primary ​dialog will display. 
 

 

4. Designate ​Label:Sensor 1​ as the primary track again, and then click ​OK​. ❏ 
Now you can see the vessel’s proximity to sensor 1 throughout the entire exercise. 
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3.6  Narrative Data 
Narrative data refers to time-stamped textual data, i.e., comments that are added during an exercise. 
One use of this is that it allows an overview of events during an exercise, but there are other 
possibilities also, such as readings from a sensor or control messages from a weapons system. 

3.6.1  Loading Narrative Data 

You load narrative data in the same way as other​ .rep​ files, by dragging-and-dropping the file into the 
plot editor. 

For this section, we need the ​“boat1.rep”​ file, so: 

1. Close the​ sample.dpf​ file and discard any changes. ❏ 

2. In the ​Navigator ​view, drag and drop the “​boat1.rep​” file into the plot editor. ❏ 

 

3. Select ​Over the Ground (OTG) ​option, and click on ​Ok​. ❏ 
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If your ​Outline ​view isn’t open, open it now. 

4. Now, still in the view, drag-and-drop the​ “narrative.rep”​ file onto the plot editor. In 
the ​Navigator ​outline view you will see​ Narratives (50 items)​. ❏ 

 

Now we need to open the ​Narrative Viewer​ itself: 

5. Press ​Ctrl+3 ​to open the ​Quick Access​ dialog, type ‘narrative’. ❏ 
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6. Select ​Narrative Viewer - CMAP​ when it appears. The ​Narrative  Viewer ​will display 

below the plot editor. In the viewer you will see the grid of narratives, including ​Time​, 
Source​, ​Type​, and ​Entry​. 

 

❏ 

 

3.6.2  The Narrative Viewer 

Within the narrative viewer, there are a number of functions that can be performed, including ​filtering 
by source​, ​filtering by type​, and​ two-way linking of narrative to current time​; we will come to 
those soon. First though, we will look at viewing and modifying the recorded narrative data. To do this: 

 

1. Double-click on any cell in the row you wish to view. The attributes for that row will 
then display in the ​Properties ​view. ❏ 

 
DebriefNG Tutorials 

www.debrief.info Page 112 of 116 

http://www.debrief.info/


Introduction to Debrief 

 

 

2. With the exception of ​Type​, you can now modify all attributes in the ​Properties 
view. We will change the color of the narrative entry where Nelson detects the first 
target zig to ‘Debrief blue’. 

❏ 
3. In the ​Narrative Viewer​, scroll down to the ​121037 ​narrative entry, you will see 

TARGET ZIG DETECTED​ in the ​Entry​ field. ❏ 
4. Double-click on that row and its properties will show in the ​Properties​ view. ❏ 
5. In the ​Properties ​view, click on the ​value ​cell next to the ​Color​ attribute and an 

ellipsis button will appear. Click on it to show the ​Color​ dialog. ❏ 
6. Click on the ​Define Custom Colors ​button then, in the ​Red, Green,​ and ​Blue 

fields, enter ​29​, ​56​ and ​96​, respectively. ❏ 
7. Click on ​Add to Custom Colors​. Then click on that color in the ​Custom Colors 

palette to select it. ❏  

 

8. Click on ​Ok​ to close the dialog and return to the ​Properties​ view. Click away from 
the ​Color​ attribute to update the color change - the narrative entry will update 
accordingly. 

❏ 

We will now look at common functions in the ​Narrative Viewer​. 
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3.6.3  Filtering by Source 

Debrief ​allows you to filter the data by source. This is useful if you have multiple tracks on your plot and 
you don’t wish to view narratives from all sources. 

1. In the ​Narrative Viewer​, click on the drop-down arrow to the right of the view toolbar 
and the ​view menu​ will open. ❏ 

2. Click on​ Set source filter​ and the ​Filter by: source​ dialog will display. Here you will 
see two columns: ​Available items​ and ​Show entries matching​. ❏ 

3. Select the entry you require from the left ​Available Items​ column, or select the entry 
you don’t wish to view from the right ​Show entries matching ​column. ❏ 

4. Click on the single chevron button to transfer items individually from one column to 
the other, or the double chevron button to transfer all at once (I selected ​Nelson​). ❏ 

5. Once you have the sources you require in the ​Show entries matching​ column, 
click on ​Ok​. ❏ 

6. The narrative entries for the selected sources will populate the ​Narrative Viewer​. ❏ 

 

3.6.4 Filtering by Type 

In the same manner as ​Filtering by source​, you can also​ filter by type​ (of narrative entry). The ​type 
of narrative entry is an optional parameter, and the first data-file we used doesn’t contain ​type ​data. So, 
we’ll remove this narrative data, and load some suitable data. 

1. In the ​Outline ​view, right-click on ​Narratives (50 items)​ and select ​Delete 
Narratives​; this will remove this narrative file from the view. ❏ 
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2. Now, in the ​Navigator ​view, locate the ​“narrative2.rep”​ file and drag and drop it 
into the editor. ​Narrative (19 items)​ will display in the ​Outline ​view. ❏ 

3. If the ​Navigator Viewer​ is blank, close it and reopen it to refresh the display; the 
entire set of narrative data will be listed. ❏ 

4. In the ​Narrative Viewer​, click on the drop-down arrow for the view menu. ❏ 

5. Click on ​Set type ​filter and the ​Filter by: type​ dialog will display. As before, you will 
see two columns:​ Available items​ and ​Show entries matching​. 

 

❏ 
6. Select the entries you require and click on the chevron buttons to transfer the items 

individually or as one from one column to the other (I selected ​CMD_COMMENT​). ❏ 
7. Once you have the sources you require in the ​Show entries matching​ column, 

click on ​Ok​. ❏ 
8. The data for the filtered narratives will populate the ​Narrative Viewer​. ❏ 
9. If you double-click on a data cell, that information will display in the ​Properties ​view. 

Note the ​Type ​attribute will show ​CMD_COMMENT​. ❏ 
Note: ​a quick way of accessing either of the ​Source ​or ​Type ​filter options is to double-click on the 
respective header cell in the ​Narrative Viewer​. 

3.6.5 Two-way Linking of Narrative to Current Time 

The ​Narrative Viewer ​also allows you to link the narrative to the time currently displayed in the plot 
editor. This way you can follow the exercise through, see what comments have been made at which 
point, and obtain a better understanding of events for your own analysis. 

1. In the ​Narrative Viewer​ toolbar, click on the end-right button to turn on this feature 
(the tooltip says ​Whether to control the current time​). ❏ 

2. In the ​Time Controller​ view, advance the time and not only will see you see the 
vessel positions change on the track, but also the narrative will advance accordingly. 

 

❏ 
Because we have a filtered set of narrative entries, it won’t advance that quickly through the data 
entries, so let’s add some more data types. 

3. Click on the drop-down arrow for the ​View ​menu. ❏ 
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4. Click on ​Set type filter ​and the ​Filter by: type​ dialog will display. Add 
SONAR_COMMENT​ and ​NEW_CONTACT​. Click on ​Ok​. The ​Narrative Viewer​ will 
show more data. 

 

❏ 
5. As you advance the track now, you can see where the vessel is for each data entry 

point. ❏ 

3.6.5.1 Jump to a Specified Time 

Another good method for analysing scenario events is to jump to specific times in the narrative. With 
the two-way linking mode still turned on, you can do this by double-clicking on a narrative entry. 

1. Double-click on the ​120612 NELSON​ narrative entry, the one marked ​NEW 
CONTACT...@​. You can see the vessel positions where red contacts blue. The time 
slider also jumps to this time. 

❏ 

2. Next, double-click on ​120957 Collingwood, NEW_CONTACT, SUSPECTED 
DETECTION OF RED​ and observe the vessel positions when blue sees red for the 
first time. 

❏ 

3. Six minutes later, blue notices that red has zigged ​(121013...SUSPECT TARGET 
ZIG)​. ❏ 

I think you’ll agree, it’s a good way of following a scenario by aligning specific narratives to track 
positions. 

Done 

That’s the essential components of the ​Narrative Viewer​ complete; in the next tutorial we will look at 
Single-sided Reconstruction ​scenarios. 

 

 

 

Signed: ________________  Date: ___________________ 
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